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Abstract

We have developed a graphical user interface (GUI) based package µ2mech to perform phase-field simulation for predicting mi-
crostructure evolution. The package can take inputs from ab initio calculations and CALPHAD (Calculation of Phase Diagrams)
tools for quantitative microstructure prediction. The package also provides a seamless connection to transfer output from the
mesoscale phase field method to the microscale finite element analysis for mechanical property prediction. Such a multiscale sim-
ulation package can facilitate microstructure-property correlation, one of the cornerstones in accelerated materials development
within the integrated computational materials engineering (ICME) framework.

1. Introduction

The age-old practice of trial and error-based experimental
methods for developing new materials is being replaced by
ICME-based methods. The latter reduces the cost and time re-
quired for developing new materials. While designing a new
alloy, predicting its microstructure is one of the most crucial
steps. Although elastic stiffness constants of materials are in-
trinsic (as they depend on bonding), the microstructure can be
controlled by processing conditions, allowing the tuning of ef-
fective mechanical properties. Thus, a package combining mi-
crostructure modeling and mechanical property prediction can
be convenient for alloy design.

Phase field simulation is the most popular technique used
for microstructure modeling.[1, 2] In recent years, phase field
simulations have been used to simulate complex microstruc-
tures evolution during different processes, such as solidifi-
cation [3–6], spinodal decomposition [7–9], precipitate/grain
growth [10? –15], coarsening [16? ], and the effect of an exter-
nal field[17, 18].

One popular tool researchers utilize is MOOSE (Multi-
physics Object Oriented Simulation Environment) [19]. This
powerful software offers a range of capabilities for conducting
complex multiphysics simulations. MOOSE is a flexible and
extensible platform that empowers the development of phase
field simulations. Its application extends to the study of mi-
crostructural evolution and dendritic growth[20]. Another valu-
able resource in this field is OpenPhase [21], a library dedicated
to implementing the multiphase field method for simulating mi-
crostructure evolution during materials processing. OpenPhase
excels in various applications, including grain growth and solid-
ification, while offering high-performance capabilities through
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distributed memory simulation. The ”Parallel Algorithms for
Crystal Evolution in 3D” (PACE3D)[22], offers an integrated
solution for addressing multi-physics applications in a parallel
and efficient manner. The solver architecture within PACE3D
encompasses diffuse interface methods, grain growth, grain
coarsening, solidification, fluid dynamics, mechanical interac-
tions, and electrochemistry. Another recently developed tool
is MicroSim[23]; it comprises multiple modules, encompass-
ing a grand-potential based solver, Kim Kim Suzuki (KKS)[24]
models for OpenCL[25] and CUDA[26], a Cahn-Hilliard model
with FFTW, and OpenFoam-based solvers[27] for multiphysics
simulations. MicroSim incorporates a user-friendly graphical
interface that enables users to easily create input files, select
solvers, and visualize simulation results using Paraview[28].
Despite the advantages provided by these tools, certain lim-
itations hinder their accessibility. MOOSE and OpenPhase,
for instance, have steep learning curves, which can pose chal-
lenges for programmers or researchers seeking user-friendly
interfaces for their simulations. Additionally, the absence of
built-in graphical user interfaces (GUIs) to visualize output in
these tools can be cumbersome for new users.

In studying microstructures and their impact on ma-
terial properties, OOF2 (Object-Oriented Finite Element
Analysis)[29] stands out as specialized software. By employing
finite element analysis techniques, OOF2 enables researchers
to simulate the intricate behavior of complex structures at the
microscopic level. Its user-friendly interface facilitates the def-
inition of material properties, boundary conditions, and loading
conditions. Moreover, OOF2 offers a comprehensive range of
features for analyzing and visualizing microstructures, encom-
passing grain boundaries, phase distributions, and stress/strain
fields. By simulating the relationship between microstructure
and mechanical properties, OOF2 facilitates investigations into
the influence of diverse microstructural features on material be-
havior. Two other prominent software packages commonly em-
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ployed for finite element analysis and microstructural studies
are ABAQUS[30] and ANSYS[31]. ABAQUS, a widely used
commercial software, offers advanced capabilities for investi-
gating the mechanical properties of materials, including mi-
crostructures. On the other hand, ANSYS encompasses a suite
of simulation tools, including finite element analysis, with spe-
cific modules such as ANSYS Mechanical and ANSYS Multi-
physics catering to the study of microstructural behavior. These
software packages enable researchers to simulate material de-
formation, phase transformations, and grain boundary effects.
Notably, both ANSYS and ABAQUS provide the ability to per-
form finite element analysis of microstructures, incorporating
crystal plasticity through the use of CPFEM (Crystal Plasticity
Finite Element Method)[32] by utilizing their respective sub-
routines.

Microstructure-based mechanical property prediction in-
volves scale bridging, from mesoscale phase-field modeling to
macroscale finite element analysis. While stand-alone pack-
ages are available for both the length scales, a package com-
bining them does not exist, to the best of our knowledge. Mo-
tivated by this, we develop µ2mech software. It can simulate
the microstructure of materials using phase-field techniques.
The software uses various open-source libraries for numeri-
cal computation, visualization, and data analysis. The package
can take inputs from ab initio calculations, and CALPHAD[33]
software like ThermoCalc [34] for quantitative microstructure
prediction. Its features include the ability to simulate bi-
nary microstructures for spinodal decomposition and precipi-
tate growth, visualization of microstructures in 2D and 3D, and
calculating particle size and volume. Additionally, µ2mech can
be coupled with OOF2 to study the mechanical behavior of the
simulated microstructures.

The paper aims to comprehensively describe the µ2mech
package, including a brief description of CALPHAD integra-
tion, numerical implementation of the phase field technique,
and installation. We discuss an example of FeCr binary al-
loy, showcasing the capabilities of µ2mech to simulate the mi-
crostructure and its integration with OOF2 for mechanical prop-
erty prediction. The example of FeCr binary alloy also serves
as a manual for users, providing guidelines regarding various
inputs to the code and outputs generated. Finally, we discuss
the impact that µ2mech can have on the materials science and
engineering community.

2. Software description

The software package comprises three main steps: prepro-
cessing, partial differential equation (PDE) solver, and post-
processing. Figure 1(a) schematically shows the software’s ar-
chitecture, process flow, and capabilities. During preprocess-
ing, users must select the calculation type (2D or 3D) and other
input parameters. Then, the software numerically solves the
governing PDEs and generates the microstructure evolution as
a function of time. In the post-processing stage, users can visu-
alize the evolution of the microstructure and do many analyses
(like particle size distribution and composition profile). Finally,
users can create input files for finite element analysis via OOF2,

allowing researchers to simulate materials’ mechanical behav-
ior under various loading conditions. Coupling with OOF2 is
chosen as it can account for the material property’s nonlinear-
ity by generating a mesh according to the morphology of the
underlying microstructure.

The architecture comprises two main components: GUI (pre
and post-processing) and the PDE solver. The latter is entirely
written in the programming language C. The discretized equa-
tions are solved using the Fourier spectral method, and it em-
ploys the FFTW library[35] to perform these calculations. In
the following section, we describe some technical details re-
lated to the phase-field method, like CALPHAD integration and
the numerical scheme to solve the Cahn-Hilliard equation. The
GUI component, which provides a user-friendly interface for
interacting with the software, is written in Python3 by utilizing
the PySide2 framework [36]. The µ2mech package also incor-
porates several other libraries such as NumPy for matrix ma-
nipulation, Matplotlib for plotting 2D microstructure intersec-
tions, PyVistaQT for visualizing vtk files, PyYAML for project
configuration and saving, and FFmpeg [37] for generating mi-
crostructure evolution animations. For its coupling with OOF2
[29, 38], µ2mech prepares an input Python script once the mi-
crostructure image is passed along with other input parameters.

Detailed installation instructions are given in Appendix Ap-
pendix A. Post-installation, the directory structure is illustrated
in Figure 1(b). The C source codes and their compiled bina-
ries for the phase field calculations are found in the “Sources”
folder. A Makefile has been provided to recompile the source
files. Typically, recompilation is not needed unless modifica-
tions have been made in one of the source files. The “Coeff”
sub-folder within the “TC Data” directory encompasses ther-
modynamic details pertinent to the binary alloys, which are cru-
cial for conducting the phase field calculations. These details
are stored in the csv format, which follows the naming conven-
tion “A-B.csv”, where A and B are the constituent elements.
An example for the Fe-Cr alloy is illustrated in Table B.1 [Ap-
pendix Appendix B]. Contained within the “Phase Diagram”
sub-folder of the “TC Data” directory are the phase diagrams,
serving as a visual reference and not directly involved in the cal-
culation process. The directory labeled as “Output” temporarily
holds the resulting data from the computations of phase field.
The “Post Processing” directory temporarily stores the compo-
sition plot generated during the post-processing stage. Other
folders like “Forms,” “Images,” “Modulus,” and “OOF2” are
mainly responsible for the GUI part of µ2mech, and it is rec-
ommended not to modify these directories.

3. Algorithm: Phase-Field modeling

The Cahn-Hilliard equation is a fourth-order, nonlinear par-
tial differential equation crucial in studying phase separation
and microstructure evolution in multi-component systems. It
has been extensively applied to model the time-dependent be-
havior of various materials, including alloys, polymers, and
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a) b)
Figure 1: a) Flowchart depicting the complete process flow of µ2mech, encompassing all essential steps. b) Folder structure overview of µ2mech, outlining the
organization of directories.
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Figure 2: Main window of µ2mech.

colloids[39]. One can write the Cahn-Hilliard equation as,

∂ϕ

∂t
= ∇ ·

[
M(ϕ)∇

(
δF
δϕ

)]
, (1)

where t is the time, M(ϕ) is the mobility function, F represents
the free energy functional, and δF

δϕ
is the variational derivative

of F with respect to ϕ. The free energy functional typically
comprises a bulk free energy term fb(ϕ) and a gradient energy
term κ|∇ϕ|2.

The Fourier spectral method is a powerful numerical tech-
nique for solving the Cahn-Hilliard equation in 2D and 3D con-
figurations, offering a robust and efficient approach to studying
complex microstructure systems[40]. It relies on the Fourier
transform to convert the spatial derivatives into algebraic oper-
ations in the frequency domain[40]. This approach allows for
efficient and accurate computation of the solution. The Fourier
spectral method involves discretizing the time variable using
a suitable time-stepping scheme, such as the semi-implicit or
fully implicit method[41]. Then, the Fourier transform is taken
with respect to the spatial variables x, y, and z (for 3D) or just x
and y (for 2D), yielding an equation in the frequency domain,

∂ϕ̂

∂t
= −M(ϕ)

[
k4ϕ̂ + k2 ˆf ′b(ϕ)

]
, (2)

where ϕ̂ and ˆf ′b(ϕ) are the Fourier transforms of ϕ and f ′b(ϕ) =
δ fb(ϕ)
δϕ

, respectively, and k2 = k2
x + k2

y + k2
z (in 3D) or k2 = k2

x + k2
y

(in 2D).
The next step is to solve the frequency-domain equation for

ϕ̂(t) and update the solution at each time step. Starting from
the initial condition ϕ(x, 0) and its discrete Fourier transform
ϕ̂(0) with respect to the spatial variables, one studies the time

evolution by updating ϕ̂(t) using an appropriate time-stepping
scheme, like the semi-implicit Euler method,

ϕ̂n+1 =
ϕ̂n − ∆t · M(ϕn) · k2 ˆf ′b(ϕn)

1 + ∆t · κ · M(ϕn) · k4 , (3)

where ∆t is the time step, and the superscript n denotes the time
level and κ is gradient energy coefficient . The mobility function
M(ϕ) can also be incorporated into the time-stepping scheme.
Once the updated solution ϕ̂n+1 is obtained in the frequency do-
main, the inverse Fourier transform is applied to recover the
solution ϕ(x, tn+1) in the spatial domain [42]. One repeats this
procedure until the desired final time is reached.

One can efficiently implement the Fourier spectral method
for solving the Cahn-Hilliard equation using the Fast Fourier
Transform (FFT) algorithm, which significantly reduces the
computational cost compared to traditional finite difference or
finite element methods [43, 44]. Moreover, the spectral method
offers high accuracy and preserves the smoothness of the solu-
tion, making it well-suited for studying the evolution of com-
plex microstructures [45].

4. Illustrative example

To demonstrate the capabilities of µ2mech, we present an
example of a binary system, Fe-Cr, using Gibbs free energy
data from CALPHAD calculations [technical details provided
in Appendix Appendix B]. The main window of µ2mech is
illustrated in Figure 2. As shown in the diagram, users click
the “New” submenu under the “File” menu to start a new cal-
culation, which opens the New dialog box [Figure 3]. In
this dialog box, the users select either Cahn Hilliard 2D alloy

4



a) b)
Figure 3: Top panels show the calculation types, (a) 2D and (b) 3D phase field simulations. The bottom panels illustrate the simulation parameters, such as alloy,
temperature, average composition, system size, mobility, kappa, and time interval. These parameters play a crucial role in defining the simulation setup and needs
to be adjusted carefully.

Figure 4: Gibbs Energy versus Composition Plot for Fe-Cr alloy at 400°C. The
plot highlights inflection points (0.27 and 0.75) and binodal points (0.10 and
0.92) in mole fraction of Cr.

or Cahn Hilliard 3D alloy from the “Calculation type↓” drop-
down menu, as shown in the top row of Figure 3. This action
loads the default parameters for calculations. Next, the users

can click the button near the top right of
the main µ2mech window [Figure 2]. This action opens the

Edit Parameters dialog box, as shown in the bottom row of
Figure 3. Next, users select Fe-Cr from the “Alloy↓” drop-
down menu [Figure 3]. At present, the other available option is
Fe-Cu . Users can add more alloy systems by creating a newal-

loy.csv file in the format specified in Table B.1 [Appendix Ap-
pendix B] and saving it in the folder TC Data/Coff. To use
this new data, users have to restart the application. Users can
visualize the phase diagram for the given system by clicking on

the adjacent button. The users then select
the temperature from the “Temperature↓” drop-down menu and
view the Gibbs free energy versus composition plot by clicking

the adjacent button [Figure 3]. A point on
the curve fixes the average composition for the alloy. When the
temperature is 400◦C for the Fe-Cr system, the spinodal phase
forms within the 0.27 ≤ X ≤ 0.75 (inflection points on free
energy curve, Figure 4).

If required, the users can modify other parameters before run-
ning the simulation [bottom row of Figure 3]. The list of pa-
rameters includes “Fluctuation” (a Gaussian noise added on top
of the average composition to generate the initial composition
field), “lx, ly, lz” (system size), “delta x, delta y, delta z” (grid
size), “delta t” (time interval), “Mobility”, and “Kappa”. The
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Upload to
cluster

Figure 5: The figure illustrate the sequential steps involved in running a calcu-
lation in a high performance cluster (HPC).

symbols used are consistent with Equations 1, 2, 3. All the pa-
rameters are self-explanatory and consistent with Section 3. In
this example, we choose lx=ly=400 with delta x=delta y=0.4,
which implies a mesh size of 100 × 100. “Fluctuation” 0.0001
defines the initial composition field as “Average composition”
0.4± a Gaussian noise with width 0.0001 at every grid point of
the mesh.

After editing the parameters, users return to the main win-
dow of µ2mech and set the “total time” for the phase-field
simulation to run and “time interval” after which simulated
microstructures are saved for visualization and other analysis.
In this example, the total time for microstructure evolution is
1000, and the interval for saving microstructures is 50 [Fig-
ure 2]. Next, the users can choose between two options: (i)
click the “Save as” submenu under the “File” menu to save the
project, transfer the files and run the calculations on a remote
machine, such as a high-performance cluster (HPC) or (ii) click

the button to perform the calculations lo-
cally on a desktop/workstation.

To run the calculations in a remote HPC, the user first trans-
fers the entire project folder (saved in the *.pf format) to the
HPC [Figure 5]. Assuming slurm workload manager is installed
in the HPC, a job submission command may look like sbatch
slurm.sh, where slurm.sh is a bash file containing the scheduler
parameters and commands required for calculation. However,
the exact command will depend on the installations in an HPC.
Once completed, the user transfers the files back to the local
machine and uses the “Load” submenu under the “File” menu
in the main µ2mech window to load the finished calculations
as a project to do further analysis.

To run the calculations locally, the user clicks the

button in the main µ2mech window [Fig-

ure 2]. The status bar below the button in-
dicates the progress of the calculations, and the calculation can
be paused and resumed as needed. “Save as” and “Load” op-
tions are available under the “File” menu in the main µ2mech
window [Figure 2]. After the run, the user can save the project
files using the “Save as” option, which saves the input and out-
put files. The file extension for saving the project is *.pf. When
loading the project, the corresponding *.pf file must be selected.
After loading the project, the users can either resume the cal-
culations for more time steps or perform post-processing. To
perform additional time evolution, one has to increase the to-

b)

a)

Figure 6: a) A 2D and (b) a 3D microstructure of a binary alloy are displayed at
the 600th time step, following the completion of calculation. Microstructures
at different time steps can be accessed using the time slider at the bottom.

6



tal time and click the button in the main
µ2mech window [Figure 6].

Users can visualize microstructures in the main µ2mech
window itself. The microstructures for different time steps
are accessible by clicking the left/right arrow key or sliding
the slider. Figure 6 depict the 2D and 3D microstructure at
600th time step. Users can customize the color scheme for the
microstructure visualization by selecting the “Plot Colors” op-
tion within the “Options” menu [Figure 6], which opens a new
dialog box Plot Colors , as depicted in Figure 7. The simu-
lated microstructures can be saved (using “Save Plot” or “Save
all plots”) or exported as an animation (using “Export Anima-
tion”). These options are available under the “File” menu in the
main µ2mech window [Figure 2].

The users can start the post-processing exercise by click-

ing the button located at the bottom right
of the primary µ2mech window [Figure 6], which opens the

Post Processing dialog box, as shown in Figure 8. Available
options are a) particle size distribution, b) composition profile
analysis, and c) property prediction. Particle size distribution

at each time step can be analyzed by selecting the
button. Particle size information appears in a small dialog box,
as shown in Figure 8. For the composition profile analysis,
users can choose a point by clicking on the microstructure in
the main µ2mech window. For example, the coordinate of the
chosen point is (X, Y)=(166,359) in Figure 8. The composi-
tion profile is drawn along a horizontal or vertical line passing
through the selected point. As shown in Figure 8, this exam-
ple draws the composition profile along the horizontal (x) di-

rection. Clicking on the button creates the
composition plot along the designated direction, as illustrated
in Figure 8. Users can visualize the time evolution of the com-
position profile by clicking the left/right arrow key or sliding
the slider (located at the bottom of the Post Processing subwin-
dow). Users can also save the composition profile(s) using the
“Save Plots” or “Save all plots” options and make an animation
using the “Export Animation” option by clicking the respective

buttons in the Post Processing dialog box [Figure
8].

The property prediction feature of the post-processing mod-
ule of µ2mech allows users to predict elastic properties by
performing Finite Element Analysis (FEA) directly over the
simulated microstructure (obtained via phase field modeling).
The current version of µ2mech allows the prediction of elastic
properties from 2D microstructures containing only two phases,
which is accomplished by integrating µ2mech with OOF2, an
open-source object-oriented finite element method software de-
veloped by NIST, USA[29].

First, let us describe the general operation of OOF2 briefly.
OOF2 takes a microstructure and allows users to identify phases
based on the constituent phases’ pixel values (or gray-scale val-

ues). Next, OOF2 needs the elastic properties of the individ-
ual phases to be added by the user. If the phases are isotropic,
only two material properties, namely elastic modulus and Pois-
son’s ratio, are needed as input, while based on the degree of
anisotropy, multiple components of the elastic stiffness matrix,
known as the elastic constants, are needed. Once the phases are
identified, it allows the users to build a “skeleton” that identi-
fies the boundaries of the phases so that a mesh with elements
and nodes conforming to the phase boundaries can be gener-
ated. Building the skeleton requires initial input from the user
regarding the number of elements along the horizontal edges (or
x-direction) and along the vertical edges (or y-direction). Mesh
generation involves further refinement of the elements so that
the elements conform to the phase boundaries, as described be-
fore. Before meshing, OOF2 allows users to choose triangular
or quadrilateral elements, similar to those found in ABAQUS,
a commercial finite element software. Mesh generation is fol-
lowed by the assignment of boundary conditions. Displacement
boundary conditions are imposed on the microstructure’s left,
right, top, and bottom edges. The displacements are applied in
terms of pixels. This is followed by solving the finite element
model using the default iterative solver available with OOF2.
Post-processing involves a calculation of the area average of
the required stress and strain components, from which the elas-
tic properties can be calculated.

These operations are automated via a python code that is in-
tegrated within the µ2mech which calls OOF2 (which should
be separately installed), loads the specified virtual phase-field
model-generated microstructure, applies the boundary condi-
tions for a simulated tensile test (along the horizontal axis or
the vertical axis), solves the finite element model, and per-
forms post-processing operations, calculating the elastic prop-
erties and saving these properties in a file at a chosen desti-
nation. User inputs are required for material properties of the
constituent phases of the microstructure, for the selection of the
type of element, for quantifying the displacements applied on
the boundaries of the microstructure, and for the choice of des-
tination for saving the output files. It is important to note here
that only a small set of features of OOF2 software are being uti-
lized by µ2mech through a Python code that automates virtual
tensile tests in an elastic regime for a microstructure contain-
ing two phases, one of which is continuous, while the other is
discontinuous. To explore the full features of OOF2, it is rec-
ommended that the users export the generated microstructural
image files and open these files directly in OOF2, i.e., outside
the environment of µ2mech. The following steps must be fol-
lowed to initiate the evaluation of the elastic properties (namely
elastic moduli and Poisson’s ratio) in µ2mech.

First, the users click on the button in the
Post Processing dialog box, which opens another dialog box

OOF2 Calculation , as shown in Figure 9. In this dialog box,

the users click on the mouse-shaped button , which allows
the users to click on the continuous phase in the main µ2mech
window displaying the microstructure. µ2mech uses the burn
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a) b) c)

Figure 7: The Plot Colors dialog box for adjusting the appearance of line and microstructure plots. For 2D line plots, color selection is available. In the case
of microstructure plots (both 2D and 3D), users can choose between two plot gradient types: continuous and discrete with their color gradient. Additionally,
surface/volume plot options are provided for visualizing outer planes and partially transparent isosurfaces, respectively.

Figure 8: The Post Processing dialog box for 2D microstructure analysis. The
main dialog box contains options for composition profile, particle size, and ex-
porting plots and animations related to the composition profile. By clicking the
Particles Info. button, a small additional dialog box appears atop the previous
one, displaying detailed particle size information.

Figure 9: Dialog box related to OOF2 Calculation.
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and invert options associated with pixel-selection methods of
OOF2 for phase identification. The burn operation works by
selecting contiguous pixels of the same color (i.e., RGB or
gray-scale pixel values) for one phase until it encounters pix-
els with different colors (or pixel values). The invert option can
be used only if the second phase is discontinuous, and it selects
pixels other than those stored using the burn operation of the
continuous phase. These operations happen in the background.
On clicking on the continuous phase, only the x and y coor-
dinate values of the point of mouse-click are displayed in the

OOF2 Calculation dialog box next to the button.
Next, the users enter the elastic constants for both phases

under the header “Elastic Constants (in GPa)”. At present,
µ2mech can only work with microstructures where one or both
phases are either isotropic or cubic in terms of material symme-
try. For an isotropic phase, the values of the elastic constants
can be calculated from Young’s modulus and Poisson’s ratio.
Elastic constant values are either obtained from the experimen-
tal data or from ab initio calculations. Determination of elas-
tic constants from ab initio calculations have been discussed
briefly in Appendix Appendix C.

Next, the users enter the number of elements along the hori-
zontal and vertical edges of the microstructure in the boxes be-
side “X elements” and “Y elements” under the header “Mesh”.
This is followed by choosing the element type by clicking on
the drop-down menu for “Element type↓” under the header
“Mesh” and selecting “TriSkeleton” or “QuadSkeleton”. OOF2
allows only two geometries of elements, viz. triangular and
quadrilateral, with triangular elements (“TriSkeleton”) as the
default option. This initiates the process of building the skele-
ton and is followed by meshing. OOF2 generates an adapted
mesh using its skeleton modification tools to account for the mi-
crostructure’s geometrical heterogeneity. An example of mesh-
ing has been illustrated in Figure 10.

Next, the users enter the boundary conditions for a simulated
tensile test (in elastic regime) along the horizontal (or x) direc-
tion under the header “Boundary Conditions (in Pixel)”. Dis-
placements are applied in terms of number of pixels in OOF2.
OOF2 considers displacements along the +x-direction positive
and displacements along the −x-direction negative. Hence, for
a tensile test along the horizontal direction, normal displace-
ments need to be applied along the outer normals, i.e., perpen-
dicular to the left and right edges of the microstructure. Hence,
the normal displacement applied on the left edge has a negative
value, while that on the right edge has a positive value. It is rec-
ommended that the displacements along the left and right edges
should have the same magnitude (i.e., absolute value without
the positive or negative signs). The users should enter a nega-
tive value for the displacement in the box beside “Left” and a
positive value (of the same magnitude) beside “Right”.

The users must specify the output path to store the output
files from OOF2. OOF2 generates files with area-averaged
stress and strain component values, from which the elastic prop-

erties are calculated. Finally, clicking on the button
initiates the FEM calculations. At this point, OOF2 starts run-

Adapted Mesh

Skeleton       

Property 

prediction

Microstructure

FEA

Figure 10: Mesh adaption in OOF2 from input skeleton through skeleton mod-
ification tools.

ning in the background. While the calculation is running, the
status bar at the bottom left will show the status “Performing
calculation”, and upon completion, output files for stress, strain,
and mesh are generated at the specified output path. Once
OOF2 operations are completed, the computed elastic proper-
ties, i.e., Young’s modulus and Poisson’s ratio, are displayed at
the bottom of the dialog box.

5. Impact

Replacing the age-old trial-and-error method for developing
new alloys using the ICME framework requires the integration
of multiple time and length-scale simulations. The µ2mech
package integrates microstructure prediction via the mesoscale
phase field method to the microscale finite element analysis for
mechanical property prediction. The package can quantitatively
predict by taking inputs from CALPHAD and ab initio calcula-
tions. Such a multiscale package will be handy for the materials
science and engineering community, especially those working
in alloy development and microstructure engineering for mod-
ulating mechanical properties.

Some salient features of the µ2mech package are the fol-
lowing. The software’s architecture, including open-source li-
braries, makes it easy to use and accessible to a broader range
of users. The graphical user interface makes it very easy to
run the code, even for beginners. At the same time, the code-
base is written in such a way that newer components can easily

9



be added. Its modular approach allows flexibility to incorpo-
rate different phase field models, making it a valuable tool for
advanced users as well. With the increasing application of ar-
tificial intelligence (AI) in phase-field modeling[46], a pack-
age like µ2mech will be convenient for relatively effortless mi-
crostructure generation in bulk, which can be further used for
training machine learning (ML) models.
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Appendix A. Installation Instructions

Follow the steps below to install and run mu2mech on your
linux system:

1. Download and extract mu2mech
wget https://github.com/mu2mech/mu2mech
unzip mu2mech.zip

2. Create and activate a Python environment: python3 -m
venv mu2mech-env
source mu2mech-env/bin/activate

3. Install packages:
pip install -r requirements.txt
sudo apt install ffmpeg

4. Run the program:
python3 mu2mech.py

Troubleshooting: Following are some common errors one
may encounter during the installation or execution of mu2mech
and suggested remedies.

• ImportError: libOpenGL.so.0: cannot open shared
object file: No such file or directory
Resolve this issue by installing the libopengl0 package:
sudo apt install libopengl0 -y

• qt.qpa.plugin: Could not load the Qt platform plugin
”xcb” in ”” even though it was found.
Reinstall the libxcb-xinerama0 package to fix this
problem:
sudo apt-get install –reinstall libxcb-xinerama0

Appendix B. CALPHAD integration

The system’s free energy strongly influences the equilibrium
compositions of the phases and subsequent microstructure evo-
lution. CALPHAD (Calculation of Phase Diagrams) tools, such
as Thermo-Calc, OpenCalphad, and Pandat, have become in-
valuable for obtaining thermodynamic data for studying alloy
systems. These tools employ computational methods to cal-
culate phase equilibria, phase diagrams, and thermodynamic
properties based on a combination of experimental data and the-
oretical models.

One extracts the data points from the free energy curve and
constructs a common tangent between individual valleys to de-
termine the equilibrium compositions. The equilibrium points
represent the compositions at which the system is in a minimum
free energy state. These points are crucial for characterizing the
stable phases and predicting phase transformations in the alloy
system. One can identify the equilibrium points using math-
ematical tools such as OCTAVE or Thermo-Calc single-point
calculation. One can approximate the free energy by a simple
4th-order polynomial equation:

G = A(c − c1)2(c − c2)2 (B.1)

where c1 and c2 are the equilibrium compositions and A is a
constant that influences the barrier height of the free energy
curve. This polynomial equation provides a mathematical rep-
resentation of the free energy curve and enables further analysis
and calculations. One can express the polynomial equation as:

G = A1c4 + A2c3 + A3c2 + A4c + A5 (B.2)

where A1 = A, A2 = A(c1 + c2), A3 = A(c2
1 + c2

2 + 4c1c2),
A4 = −2Ac1c2(c1 + c2), and A5 = Ac2

1c2
2. These polynomial

coefficients allow for the direct calculation of the free energy
values at different compositions within the alloy system.

The scaled free energy is utilized in our simulation, where the
free energy equation above is divided by A. This scaling is nec-
essary to ensure that the magnitude of the free energy values is
appropriate for numerical calculations and simulations. For ex-
ample, at a specific temperature, the equilibrium compositions
c1 and c2 are determined based on the analysis of the free en-
ergy curve. The polynomial coefficients A1, A2, A3, A4, and A5
can then be calculated using the Equation B.2. This approach
can be extended to other temperatures of interest, allowing for
the construction of polynomial equations that describe the free
energy behavior at those temperatures. Integrating these poly-
nomial equations with a phase field model makes it possible to
simulate and analyze the alloy system’s microstructure evolu-
tion and phase transformations under different thermodynamic
conditions.

Appendix C. Determination of Elastic Constants

The assessment of elastic constants begins with the initial
estimation of the bulk modulus, achieved through the utilization
of the Birch-Murnaghan equation of state,

E(V) = E(V0) +
B
B′

[
(V/V0)B′

B′ − 1
+ 1

]
−

BV0

B′ − 1
. (C.1)
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Table B.1: Table showing the ThermoCalc-extracted dataset essential for estimating the Gibbs energy plot as per Equation (2).
Temp. (◦C) Coefficients Binodal points

A1 A2 A3 A4 A5 point 1 point 2
200 1 -2.046 1.0964 -0.051 0.0006 0.025 0.998
220 1 -2.046 1.0964 -0.051 0.0006 0.025 0.998
240 1 -2.046 1.0964 -0.051 0.0006 0.025 0.998
260 1 -2.041 1.1339 -0.0943 0.0021 0.0475 0.973
280 1 -2.041 1.1339 -0.0943 0.0021 0.0475 0.973
300 1 -2.0314 1.1339 -0.0943 0.0021 0.0475 0.973
320 1 -2.0314 1.1339 -0.0943 0.0021 0.0475 0.973
340 1 -2.041 1.1789 -0.1403 0.0047 0.0725 0.948
360 1 -2.041 1.1789 -0.1403 0.0047 0.0725 0.948
380 1 -2.091 1.2779 -0.1933 0.0085 0.0975 0.948
400 1 -2.041 1.2214 -0.1837 0.0081 0.0975 0.923
420 1 -2.092 1.3212 -0.2375 0.0129 0.123 0.923
440 1 -2.092 1.2633 -0.2255 0.0122 0.123 0.898
460 1 -2.042 1.3599 -0.278 0.0177 0.148 0.898
480 1 -2.092 1.3962 -0.316 0.0228 0.173 0.873
500 1 -2.092 1.4299 -0.3513 0.0282 0.198 0.848

Energy as a function of volume is calculated using Density
Functional Theory (DFT).

To determine the values of C11 and C12, the unit cell is sub-
jected to deformation. In the case of cubic materials, the fol-
lowing volume-preserving strain is applied on the conventional
unit cell,

ε =


δ 0 0
0 −δ 0
0 0 δ2

1−δ2

 . (C.2)

This transformation changes the cubic cell to an orthorhombic
one. The energy of the deformed cell satisfies the following
equation,

E(δ) = E(0) + (C11 −C12)Vδ2. (C.3)

E(0) is the energy of the pristine structure, and E(δ) is the
energy of the deformed structure, obtained from DFT calcu-
lations. Subsequently, by recognizing that B = C11+2C12

3 , the
values of C11 and C12 can be derived.

The evaluation of C44 involves the utilization of the following
strain matrix,

ε =


0 δ/2 0
δ/2 0 0
0 0 δ2

4−δ2

 . (C.4)

Using the following equation, one can obtain the value of C44,

E(δ) = E(0) +
1
2

C44Vδ2, (C.5)

where E(δ) is the energy of the deformed structure, obtained
from DFT calculations.
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